
 
 

Prospector 2014 Release Summary 
April 2014 

Overview 
Prospector 2014 is a major release that includes significant enhancements as well as customer 
requested software modifications and corrections.  This release summary describes the software 
changes. 

Platform Support 
Prospector is no longer available for 32-bit operating systems.  If you haven’t already, you must 
upgrade your hardware and/or operating system to support 64-bit software.     
 
The table below lists the supported operating systems for Prospector 2014:  
 

Operating System Revision Level 
Windows 8.1 – 64bit 8.1 and 8.1 Update 

Windows Server 2012 R1 & R2 
Windows 8 – 64bit All 
Windows 7 – 64bit Service Pack 1 

Windows Server 2008 R2 – 64-bit  Service Pack 2 
 
The operating systems Windows Vista, Windows XP and Windows Server 2003 are no longer 
supported.  Prospector may install and run on these operating systems provided it is the 64-bit 
edition of the operating system however be advised that no quality assurance testing was 
performed on these operating systems.  Any problems with the software specific to these 
operating systems may not be repaired in future updates or releases.  You are strongly advised to 
upgrade to a supported operating system. 

Installation 
The installation program has been revised to automatically uninstall a previous version of 
Prospector if it detects one on your computer.  Previous releases required Prospector to be 
uninstalled using the Windows Control Panel before a new major release could be installed.  You 
no longer need to do this.  
 
When installing the software on a new computer that has never had previous release of 
Prospector installed, the default setting for PowerSource databases is to enable the File-Based 
user interface paradigm for working with projects.  More information on File-Based projects is 
presented later in these release notes.   
 
If you are using Prospector 2009 or later, there is no change in the license enforcement software.  
Your current validation will allow 2014 to run.   
 
The installation program has been revised to create the directory “Custom Posts” under 
ProgramData if it doesn’t already exist.  This is the recommended folder to put all custom post 
processors (.exe files) for your installation. 
 
A directory named License is automatically created under the ProgramData folder if it does not 
exist.  This directory contains files related to software licenses. 
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Working with Prospector Projects 
Major changes have been implemented for managing Prospector projects.  It is important that you 
fully understand these changes. 

The New File Menu  

The Project menu that has been a distinguishing feature of Prospector since the very beginning 
has been replaced by the Windows-standard File menu: 
 

 

 

The former Project menu on the left is replaced by the new File menu. 
 
Project/Get… and Project/Open… have been replaced by the single menu item File/Open 
Project…  Choosing File/Open Project… presents the Open Project dialog: 
 

 
New Open Project Dialog 
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Each row in the table represents one Prospector project.  The columns in the dialog provide all 
the relevant information about that project: 
 
Column Description 

Job The job number assigned to this project.  Just as before, each Job is a 
unique identifier (file folder) which means there can never be 2 jobs of the 
same name. 

Project Individual project(s) associated with a Job number.  As in previous 
releases, there can be any number of individual projects associated with a 
single job number. 

Local/Remote Indicates whether or not the project is in archive form or local to this 
computer.  In previous releases, you would use Project/Get to retrieve a 
project in archive format from the directory associated with the Remote 
Jobs directory or Project/Open to open a job that is already local to the 
computer.  The Open Project dialog performs both functions. 

Locked By If the project is being worked, this column will show which computer/user 
has that project.   

 
Clicking a column header will cause the list to be sorted by the contents of the column. 
 
The Show Project menu at the bottom of the dialog filters the display in the Open Project dialog to 
show both Remote and Local jobs, Local Only or Remote Only.   
 
File/Archive Project replaces Project/Put.  When you are finished working on a project and wish to 
off-load the data from your computer to the remote jobs directory, choose this menu item to put 
the project in archive format (.prz file format) and send it to the designated remote directory for 
the project. 
 
For clarity, File/New Project… replaces the old Project/New… and File/Close Project replaces 
Project/Close.  The new menu items perform the same function as their predecessors. 
 
The remaining items from the former Project menu have migrated to a new position on the menu 
bar just to the right of the View menu: 
 

 

The new Project menu contains items related to the current project you 
are working on in Prospector.   
 
These menu items perform the same function as the entries in the former 
Project menu. 
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File-Based Projects 

Project-based organization has historically organized data in a fashion commonly used by mold 
shops.  This level of organization offered a hierarchy of 2 levels: 
 

 

Each  job – 0015-A-6690-1 in this example – would refer to a single 
tool to be manufactured.   
 
Inside a job directory for a tool would be individual projects needed 
to machine the different components for that tool.  This would 
include core, cavity, electrodes (if any), lifters, ….   
 
  
 
 
 

 
This form of data organization is referred to as the Project-Based user interface and will be the 
default for existing customers upgrading from a previous version of Prospector.  
 
For shops that require a deeper hierarchy of data organization, Prospector now allow File-Based 
project organization.  To enable File-Based organization, use PowerSource Insight and change 
the settings in the Applications Settings / Project-Based Interface folder: 
 

 
The Project-Based Interface Setting in PowerSource Insight 

 
As shown above, disable the Project-Based interface by setting the Enable switch to “No”.  In the 
File-Based interface, the Local Job Directory and Remote Job Directory settings are ignored 
because the File-Based interface allows projects to be created and archived anywhere in the file 
system. 
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When you create a new project in the File-Based user interface, you will choose the folder for the 
project: 
 

 
Choose a folder where this project will be created…. The folder for a project can be anywhere in the file 

system.  Create a new folder if needed. 
 
Aside from choosing the location of a project, the process of creating a new project is the same in 
both File-Based and Project-Based user interfaces. 
 
The project name entered will be the name of the project file created in the directory selected: 
 

 
In this example, the project data is contained in the 
file named 0016-A4303.prj in the specified 
directory. 
 
A project file (.prj extension) contains all the data 
associated with machining this project (part data 
file, programs, attachments, ….).   
 
What a .doc or .docx file is to Microsoft Word, a .prj 
file is to Prospector. 
 
It’s that simple! 
 
 

 
 
Important Technical Note:  Inside the directory you designate for the project, a hidden directory 
if the same name of the project is created by Prospector to store data files that are created while 
working on a project.  Do not delete this hidden folder or any files in it.  Doing so would corrupt 
the project and make it unusable.   
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When you are finished machining this project, you can and should archive it by choosing 
File/Archive Project: 
 

 

Archive Project gathers together all the data files associated with the project 
that are currently saved in the hidden subdirectory, compresses the data 
and stores the result in a single file: <project name>.prz  
 
The <project name>.prj file is removed.  The hidden directory associated 
with this project is also removed. 
 
Archiving a project when you no longer need it is a good way to conserve 
disk space. 
 
Choose File/Open Project to reopen a project (.prj) or an archived project 
(.prz) file. 

 
You cannot mix and match Project-Based and File-Based projects!  If you choose to use the 
File-Based project scheme, you cannot open projects that were created using the project-Based 
scheme.  In the Project-Based user interface, you cannot open a project that was created using 
the File-Based user interface.   
 
Be advised that the default in Prospector is File-Based user interface when installing on a new 
computer that did not have Prospector installed on it previously.  If this is not wanted, make sure 
to edit the databases in PowerSource Insight or copy an existing database to the new computer 
to switch Prospector to the Project-Based user interface. 
 
If the computer you are installing on already has a previous release of Prospector, the default will 
be Project-Based because it will use your existing databases.  If you wish to switch to File-Based, 
you will need to edit the database in PowerSource Insight. 
 
If you switch to the new File-Based user interface, then find that you need to work on an older 
project that was created using the Project-Based scheme, start PowerSource Insight and enable 
the Project-Based Interface in the Application Settings folder. 
  

3D Programming 
Z-Planar Remachining has been revised to correct an error where in certain cases the tool would 
not descend to lower levels of a pocket region when it could clearly go deeper to remove the 
remaining stock. 
 
Remachining has been revised to filter out unwanted paths for the 2nd and subsequent tools 
such that the paths that are not sufficiently long to be considered viable are removed then the 
paths are filtered to remove those that do not cut the minimum number of levels specified.  This is 
a reverse of the filtering order performed by previous versions and produces more efficient 
programs. 
 
In discrete cases where a very small step down (e.g. .002”) it was possible that a 3D Z-Planar No 
Clear program could skip areas of the part data that should have been machined.  A revised 
algorithm to sort the intermediate data has been implemented to correct this problem. 
 
The Machine Floors option for Z-Planar With Clear has been corrected to produce proper results 
if only a single level was specified to be machined.  In previous versions, the level would be 
machined twice.  
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PowerSource System 
The default rule in the PowerSource database for choosing a tool for a 3D Z-Planar No Clear has 
been corrected work properly for data sets that are physically very small in size.   
 
A number of program properties did not allow the option to lock them in the system database.  All 
PowerSource program properties have been reviewed and updated to allow them to be locked if 
needed. 
 
Choosing Help from either PowerSource Insight or Tooling will present the HTML help for that 
application.  Previous versions would present the Prospector HTML help home page instead of 
the correct documentation for the application. 
 
The default PowerSource rule for Z-Planar No Clear Island Offset Distance has been revised to 
put limits on the default.  10% of the tool diameter is used as a default but this can never be 
greater than 0.1” (.25 mm) or less than .01” (.25 mm).  This prevents the cutter from coming 
dangerously close to an island during retracing in cases where a very small tool diameter is in 
effect. 

2D Machining 
A new ordering feature has been added for drilling to allow for the selection of where to start and 
the direction in which to machine.  On the Finish page of the new program wizard, you can now 
choose Use-Specified ordering: 
 

 
Choose User-Specified to customize the sequence in which holes are machined. 

 
 
 
Drill Start Quadrant Drill Cut Direction Results 

First Quadrant X-Major 
Start at the hole in the upper right corner.  Machine the remaining 
holes in strips back and forth along the X-axis working from the top 
to the bottom in Y. 

First Quadrant Y-Major 
Start at the hole in the upper right corner.  Machine the remaining 
holes in strips up and down the Y-axis working from the right to the 
left side of the set of holes. 

Second Quadrant X-Major 
Start at the hole in the upper left corner.  Machine the remaining 
holes in strips back and forth along the X-axis working from the top 
to the bottom in Y. 

Second Quadrant Y-Major 
Start at the hole in the upper left corner.  Machine the remaining 
holes in strips up and down the Y-axis working from the left to the 
right side of the set of holes. 

Third Quadrant X-Major 
Start at the hole in the lower left corner.  Machine the remaining 
holes in strips back and forth along the X-axis working from the 
bottom to the top in Y. 

Third Quadrant Y-Major 
Start at the hole in the lower left corner.  Machine the remaining 
holes in strips up and down the Y-axis working from the left to the 
right side of the set of holes. 

Fourth Quadrant X-Major 
Start at the hole in the lower right corner.  Machine the remaining 
holes in strips back and forth along the X-axis working from the 
bottom to the top in Y. 

Fourth Quadrant Y-Major 
Start at the hole in the lower right corner.  Machine the remaining 
holes in strips up and down the Y-axis working from the right to the 
left side of the set of holes. 
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Prospector Design and 3D Printing 
3D printing is a process of creating a finished part by laying down one layer of material at a time.  
The software applications that are used to create the output data that drives 3D printers take as 
input a 3D model in either STL format or AMF format.  Both STL and AMF data formats represent 
a mesh of the part data.  This mesh consists of a set of very small triangles that approximate the 
actual surface of the model.  When you view the part data in Prospector or Prospector Design as 
a shaded image, you are actually looking at a triangulated mesh of the model.  From the mesh in 
the STL or AMF file, the software provided by the 3D printer vendor cuts sections through the 
data to find the regions that need to be filled with material for each layer. 
 
In Prospector Design you can choose to output either STL or AMF data: 
 

 
 
STL data is an ASCII format 
that contains only the triangles 
that approximate the design.  
These STL files can be quite 
large. 
 
AMF data not only contains 
the triangles but also the color 
information.  AMF data is a 
compressed format to save 
disk space. 
 
The choice of STL or AMF is 
largely governed by which 
format your 3D printer 
software will accept. 
 
 

 

Corrections and Maintenance 
 
Each time you start prospector, it will automatically check if there is an update available for 
download and installation over the internet.  If there is, a dialog will be presented to offer you the 
option of downloading and installing the update.  If you wish to disable this feature, disable the 
automatic update feature in the Help menu: 

The menu item for enabling/disabling automatic updates. 
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The selection of a program in the program tree control could get out of synch if a tooltip was 
displayed by the tree control. 

 
Tooltip Note 

When the length of an item in the tree control exceeds the 
width of the control, a tooltip note as shown here is 
displayed. 
 
In previous versions, when this note was displayed, the 
actual selection in the tree control could get out of synch 
with what is shown on the screen.   
 
In other words, the program you might have selected (or 
thought you did because it was highlighted) may not be 
the actual one that was selected. 
 
This problem has been corrected so that the select 
program(s) are always shown in their proper highlighted 
state regardless of whether or not a tooltip note is shown 
as well. 

 
 
Support has been added for mouse events that were previously not supported: 
 

Shift Key + Mouse Wheel = Pan left and right 
Ctrl Key + Mouse Wheel = Pan up and down 
Alt Key + Mouse Wheel = Rotate about the X-axis of the current view 
Alt Key + Shift Key + Mouse Wheel = Rotate about the Y-axis of the current view 
Alt Key + Ctrl Key + Mouse Wheel = Rotate about the Z-axis of the current view 
Tilt Mouse Wheel (side-to-side movement of the mouse wheel) = Pan left and right 
X button 2 (front button on the side of the mouse) = Go to the next position of the current program 
X button 1 (rear button on the side of the mouse) = Go to the previous position of the current program 

 
Prospector Design and Prospector have been modified to handle these mouse events in the 
same manner so that both are consistent with each other. 
 
 2D profiling and pocketing has been revised to produce a single pass when the start Z and end Z 
coordinates are the same.  In previous versions it was possible that more than one pass could be 
created due to double-precision rounding errors 8 or more places to the right of the decimal point 
when only a single pass at the start Z was intended. 
 
A program crash or corruption of the remaining stock model could occur in situations where 
Prospector is currently generating a program a program is post processed using one or more of 
the high speed machining (HSM) options.  During program generation HSM options are 
temporarily disabled to prevent conflicts.  In the HSM dialog, a message to this effect is 
presented.  When program generation concludes, the HSM options will once again be available 
for post processing. 
 
The IGES translator has been revised to handle entities which have associated with them a 
transformation matrix (e.g. singular subfigures) properly.  In previous versions the transformation 
was being applied twice resulting in incorrectly placed entities. 
 
Application of the plunge feed rate is done in the same manner regardless of the cutting direction 
(+Z or –Z) for 3D Z-Planar No Clear.  The previous version did not apply the plunge feed rate 
properly when cutting in the +Z direction. 
 
A multi-threading programming error has been corrected could cause the remaining stock model 
to be out of synch with the actual program data if a program was post processed during program 
generation.   
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The Export Settings feature of Prospector has been revised to function correctly for Windows 8 
and Windows 8.1.  Changes to the operating system prevented the settings from being extracted 
from the Windows registry. 
 
A command line option - /silver – has been added to Prospector to force it to consume a license 
for the Silver edition in the event there is a choice of Gold or Silver license(s). 

Resolved Incident and Enhancement Report 
When you report a problem or request an enhancement by contacting our customer service team 
or reporting a problem at the web portal AMT OnTime you will receive a unique ID for each 
problem and/or requested enhancement.  When we complete a release all incidents and 
enhancements that were addressed for that particular release are assigned a closed status.  The 
following table lists the closed records for this release. 
 

ID Synopsis 
AMT0002 Missing and out of place surfaces result when this IGES file is used for the part 

data. 
AMT00111 The default rule for choosing a tool does not work well for very small part data 

sets when creating 3D Z-Planar No Clear programs. 
AMT00114 Application of the plunge feed rate is done in the same manner regardless of the 

cutting direction (+Z or –Z) for 3D Z-Planar No Clear. 
AMT00157 Cutter radius compensation option was not being presented certain dialogs. 
AMT00167 A number of program settings in PowerSource Insight are not allowed to be 

locked in the system database.  
AMT00177 Remaining stock model data can become out of synch with the NC programs if a 

program is post-processed during program generation. 
AMT00189 Revised the installation program to automatically uninstall a previous version of 

Prospector when 2014 is installed. 
AMT00192 3D Z-Planar Remachining is not machining lower levels of certain pocket areas of 

this job. 
AMT000193 Certain progress dialogs are not using the same font as the other dialogs in 

Prospector. 
AMT00197 When choosing Help from PowerSource Insight or PowerSource Tooling, the help 

for that application will be shown instead of the home page for Prospector help. 
AMT00202 Z-Planar No Clear program is not machining the entire part. 
AMT00203 The preview image for Prospector projects has been revised to always produce a 

shaded image of the part data if possible. 
AMT00204 The default viewing mode has been changed from a wireframe display to a 

shaded model display. 
AMT00212 Export Settings feature in Prospector is not working properly on the Windows 8 

platform. 
AMT00213 3D Z-Planar Remachining is not machining lower levels of certain pocket areas of 

this job. 
AMT00214 Add the ability to specify the start and order of drilling programs. 
AMT00217 Add a command line option to force Prospector to use a silver edition license in 

the even there is a choice between Gold and Silver license(s). 
AMT00218 A warning dialog will be posted if the license for Prospector is within 10 days of 

expiring. 
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AMT00220 Remaining stock model data can become out of synch with the NC programs if a 
program is post-processed during program generation. 

AMT00223 Remaining stock model data can become out of synch with the NC programs if a 
program is post-processed during program generation. 

AMT00224 Revise the installation to create the directory Custom Posts under the 
ProgramData directory. 

AMT00225 Using High Speed Machining options can cause a program crash or corruption of 
the remaining stock model during program generation. 

AMT00226 When opening a project permit the selection of a material that also has a 
configuration for the units the project was created with. 

AMT00227 This 3D Z-Planar Remachining job is gouging the part data. 
AMT00231 2D pocketing and profiling can create 2 passes at the same level when only a 

single pass is required. 
AMT00232 The Machine Floors option for Z-Planar With Clear can cause a single level to be 

machined twice if the start Z and end Z for the program are the same. 
AMT00233 Have Prospector automatically check if an update is available for download when 

the program is started. 
AMT00237 Resetting any or all of the toolbars can cause the icons in the toolbars to 

disappear. 
AMT00238 A level is being skipped in this Z-Planar Remachining sequence. 
AMT00240 Add support for other mouse events. 
AMT00241 Export Setting feature does not work on Windows 8.1 unless the login has 

Administrator rights. 
AMT00242 Prospector Design and Prospector need to be consistent with the function of the 

mouse buttons and features. 
AMT00247 This Z-Planar remachining program is not honoring the Minimum Levels in Group 

setting. 
AMT00248 The License directory under ProgramData is not being created by the installation 

program. 
AMT00250 This Z-Planar No Clear program is gouging the part data. 
AMT00251 The default PowerSource rule for island offset needs to be bounded by a 

maximum and minimum value. 
AMT00254 The warning message about data file formats for part data doesn’t reflect the fact 

that Prospector can import Parasolid and AutoCAD files. 
AMT00259 Add support for exporting the model data in a format acceptable by 3D printing 

software applications. 
AMT00263 The tooltip in the program tree can cause the user to load or post process the 

wrong program. 
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